
18 ELEKTRONIKA PRAKTYCZNA 7/2022

sklep

W  ofercie AVT*

Podstawowe parametry:
• uzyskuje się pole widzenia o zakresie 180° zarówno w płaszczyź-

nie horyzontalnej, jak i wertykalnej dla kamerki ze standardowym 
obiektywem,

• sterowanie modułem kamery odbywa się za pośrednictwem prze-
glądarki internetowej i stron generowanych przez sam moduł,

• możliwość sterowania kamerą i ramieniem za pomocą rozka-
zów wpisywanych bezpośrednio w pasku przeglądarki i przesyła-
nych w trybie GET.

AVT5943
* Uwaga! Elektroniczne zestawy do samodzielnego 
montażu. Wymagana umiejętność lutowania! 
Podstawową wersją zestawu jest wersja [B] 
nazywana potocznie KIT-em (z ang. zestaw). Zestaw 
w wersji [B] zawiera elementy elektroniczne (w tym [UK] 
– jeśli występuje w projekcie), które należy samodzielnie 
wlutować w dołączoną płytkę drukowaną (PCB). Wykaz 

elementów znajduje się w dokumentacji, która jest 
podlinkowana w opisie kitu. Mając na uwadze różne 
potrzeby naszych klientów, oferujemy dodatkowe wersje:
  wersja [C] – zmontowany, uruchomiony i przetestowany 

zestaw [B] (elementy wlutowane w płytkę PCB)
  wersja [A] – płytka drukowana bez elementów 

i dokumentacji

Kity, w których występuje układ scalony wymagający 
zaprogramowania, mają następujące dodatkowe wersje:
  wersja [A+] – płytka drukowana [A] + zaprogramowany 

układ [UK] i dokumentacja
  wersja [UK] – zaprogramowany układ
Nie każdy zestaw AVT występuje we wszystkich wersjach! 
Każda wersja ma załączony ten sam plik pdf! Podczas 

składania zamówienia upewnij się, którą wersję 
zamawiasz! – http://sklep.avt.pl. 

W przypadku braku dostępności na stronie sklepu osoby 
zainteresowane zakupem płytek drukowanych (PCB) 
prosimy o kontakt Via e-mail: kity@avt.pl.

Dodatkowe materiały do  pobrania ze  strony www.ulubionykiosk.pl/media
AVT5897 Sterownik mikroserwomechanizmów do Pi Pico (EP 11/2021)
AVT5886 16 kanałowy kontroler PWM – sterownik serwomechanizmów dla RPi Zero (EP 9/2021)
AVT5752 Rozgałęźnik dla serwomechanizmów (EP 3/2020)
AVT5731 Radiowy sterownik serwomechanizmów (EP 12/2019)
AVT1632 Tester serwomechanizmów modelarskich (EP 8/2011)
AVT5290 3-kanałowa aparatura do zdalnego sterowania modeli (EP 5/2011)
AVT1605 Dwustanowy sterownik serwomechanizmu (EP 2/2011)
AVT1570 Spowalniacz serwomechanizmu (EP 5/2010)

WYKAZ ELEMENTÓW, które możesz zamówić w  sklepie AVT na  stronie sklep.avt.pl lub bezpośrednio (ul. Leszczynowa 11, 03-197 Warszawa, tel. 48222578451, e-mail: handlowy@avt.pl):

Rezystory: (SMD0805)
R1: 1 kΩ
R2: 30 kΩ
R3: 50 kΩ
R1: 2,2 kΩ

Kondensatory:
C1: 10 μF SMD0805
C2: 100 nF SMD0805
C1: 100 nF SMD0805

C2: 10 μF SMD0805
C3, C4: 100 μF/25 V SMD

Pozostałe:
J1, J2: DG308-2,54/3 złącze śrubowe do druku
2 × listwa gniazd goldpin 1×8
K1: P-5 przekaźnik miniaturowy przewlekany 
J2: USB B-Mini gniazdo USB
J5,J6: DG308-2.54/3 złącze śrubowe do druku
J1: DG127-5.0/2 złącze śrubowe do druku

J3, J3: styki kątowe goldpin 1×3
uchwyt przegubowy do kamery FPV
2 × serwomechanizm SG90

Półprzewodniki:
D1: SMBJ5.0A dioda zabezpieczająca szybka
M1: ESP32-CAM
D1: 1N4007 SMD
Q1: BC847 SMD

PROJEKTY

Kamera z ruchomym
ramieniem
Moduł ESP32-CAM,
czyli mikrokontroler ESP32 zinte-
growany z miniaturową kamerką,
cieszy się od lat zasłużoną popu-
larnością. Za umiarkowaną cenę
użytkownik dostaje urządzenie
pozwalające uzyskać obraz wideo
o przyzwoitych parametrach. W do-
datku oprogramowanie modułu ma
otwarty kod źródłowy, co pozwala
dostosowywać je do swoich potrzeb
i pomysłów. Zapewne dlatego wciąż
powstaje wiele projektów z tym
modułem. Inspiracją dla zapre-
zentowanego projektu była po-
trzeba rozruszania ESP32-CAM
– co miało poszerzyć jego możliwo-
ści np. w opiece nad dziećmi czy
chorymi itp.

i sygnałów do ESP32-CAM. Większa płytka
pełni funkcję stabilnej podstawy dla ramie-
nia. Znajdują się na niej gniazda do przy-
łączenia kabl i serwomechanizmów,
przewodów sygnałowych zmodułu oraz ele-
menty obwodu zasilania.

Budowa i działanie
Schemat ideowy układu zamontowa-
nego na obydwu płytkach pokazany został
na rysunku 1 i rysunku 2. Jak widać, nie
jest on bardzo skomplikowany. Na schema-
cie z rysunku 1 pokazano połączenia ele-
mentów zamontowanych na małej płytce.

i wertykalnej i to dla kamerki ze standardo-
wymobiektywem.Wygląd gotowej konstruk-
cji pokazuje zdjęcie tytułowe.

Konstrukcja zdalnie 
sterowanego mechanizmu
Wskładprojektuwchodzi: ramię przegubowe
z miniaturowymi serwomechanizmami,
2 płytki drukowane i moduł ESP32-CAM,
który po zaprogramowaniu pracuje jako ser-
wer sieciowy dodatkowo sterujący ruchami
ramienia. Mniejsza z płytek drukowanych
służy do zamocowania modułu na końcu
ramienia oraz do doprowadzenia zasilania

Kamera montowana w gnieździe ZIF mo-
dułu ma niewymienny obiektyw o kącie
widzenia około 25°. W niektórych serwi-
sach internetowych oferowane są kamerki
z obiektywami o szerszym kącie, który po-
woduje zniekształcenie obrazu, czyli tzw.
efekt rybiego oka. W tym projekcie dzięki
umieszczeniu modułu na ruchomym ramie-
niuuzyskuje się pole widzenia o zakresie 180°
zarówno w płaszczyźnie horyzontalnej, jak
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Kamera z ruchomym ramieniem

Do osadzenia modułu ESP32-CAM służy
gniazdo M1 składające się z 2 listw gniazd
goldpin o rastrze 2,54 mm. Gniazdo J1 do-
starcza do modułu zasilania VCC o napię-
ciu +5 V. Na kolejnych stykach gniazda J2
wyprowadzono:
• sygnał załączania przekaźnika doprowa-
dzającego zasilanie do serw – J2-1,

• sygnały PWM sterujące serwomechani-
zmami ramienia w płaszczyźnie:
– wertykalnej – J2-2,
– horyzontalnej – J2-3.

Oporniki R2, R3 tworzą dzielnik obniżający
wartość napięcia VCC do poziomu umożli-
wiającego jego podanie na wejście
przetwornika ADC IO2. Szybka
dioda D1 dodatkowo zabezpie-
cza wejście przed przepięciami.
Pomiary napięcia VCC będą wyko-
rzystywane w kolejnych wersjach
oprogramowania.
Na schemacie z rysunku 2 po-

kazane zostały połączenia pomię-
dzy elementami zamontowanymi
na dużej płytce. Napięcie zasila-
nia +5 V z zewnętrznego zasila-
cza podawane jest na gniazdo J2
typumini USB. Do gniazda podłą-
czona jest równolegle kostka zaci-
skowaJ1.Zasilaniemożnapodłączyć
albo do gniazda, albo do kostki.

Uwaga! Obwody zasilania nie 
są zabezpieczone przed omyłkową
zmianą polaryzacji. Nie należy
podłączać zasilania jednocześnie
do gniazda i do kostki.
Gniazdo J6 służy do podania

zasilania na małą płytkę. Z kolei
zmałej płytki do gniazda J5 podawane są syg-
nały PWM sterujące serwami. Z tego sa-
mego gniazda, ze złącza J5-1 pobierany jest
sygnał załączania przekaźnika K1. Przewody
serwomechanizmównależy podłączyćdo sty-
ków złączy J3 i J4.

Montaż i uruchomienie
Montażmożna rozpocząć od złożenie rucho-
mego ramienia poruszanegominiaturowymi
serwomechanizmami typu SG90 lub MG90.
Ułatwieniemmoże być dokumentacja produ-
centa ramienia [1].
Schematy płytek PCB zostały pokazane

na rysunku 3 i na rysunku 4. Końcówki
elementów przewlekanych przeznaczonych

Rysunek 1. Schemat układu z modułem ESP32 (mała płytka)

Rysunek 2. Schemat części bazowej (duża płytka)

Rysunek 3. Schemat płytki PCB dla modułu 
ESP32 Rysunek 4. Schemat płytki PCB bazowej

domontażunamałej płytce należymaksymal-
nie skrócić i obciąć tak, żeby nie wystawały
ponad pola lutownicze.Ułatwia tomocowanie
płytki drukowanej, którą przykręca się jed-
nym wkrętem do uchwytu kamery na końcu
ramienia. Otwór pod wkręt należy wywier-
cić w plastikowej płytce uchwytu kamery.
Gniazda J1, J2 trzeba wlutować otworami dla
kabli na zewnątrz w kierunku brzegu płytki.

Z kolei na dużej płytce drukowanej śrubowe
gniazda zaciskowe J5, J6 należy wlutować ot-
worami na kable dowewnątrz płytki, co uła-
twi poprowadzenie przewodów (fotogra�a 1).

Fotografia 1. Mocowanie przewodów do du-
żej płytki
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z ustawieniami związanymi z serwome-
chanizmami. W wersji obecnej można tam
zaprogramować pozycję ramienia, którą przyj-
mie po resecie oraz ograniczenia jego ru-
chów w pionie i poziomie.
Dodatkową opcją jest możliwość sterowa-

nia kamerą i ramieniem za pomocą rozka-
zów wpisywanych bezpośrednio w pasku
przeglądarki i przesyłanych w trybie GET.
Pozwala to tworzyć skrypty i zautoma-
tyzować proces sterowania. Listę rozka-
zów można znaleźć tutaj [4].
Pliki źródłowe oprogramowania modułu

dla środowiska Arduino można pobrać tu [5].
Przed zaprogramowaniem modułu zaleca

się przeprowadzić kompilację z własnymi
ustawieniami prede�niowanymi dla wybra-
nego typumodułu. Dalszy opis dotyczyć bę-
dzie ESP32-CAMAI-THINKER z kontrolerem
wwersji ESP32-S z dostępem do dodatkowej
zamontowanej pamięci PSRAM.
Żeby móc przeprowadzić kompilację, na-

leży w środowisku Arduino mieć zainstalo-
waną obsługęmodułów z procesorem ESP32.
Jeżeli jeszcze tego nie zrobiłeś, dodaj dodat-
kowy wpis w polu
File → Preferences → Additional Board

Manager URLs:
https://raw.githubusercontent.com/espressif/
arduino-esp32/gh-pages/package_esp32_
index.json
Następnie przejdź do Tools → Boards →

ESP32Arduino i wybierz ESP32 DevModule.
Dla płytki ustaw parametry:

Oprogramowanie
Sterowanie modułem kamery odbywa się
za pośrednictwem przeglądarki interneto-
wej i stron generowanych przez sam moduł.
Oprogramowaniemodułu powstało jako roz-
szerzenie szkicu dla Arduino [2], który z kolei
bazuje na przykładowym opracowaniu pro-
ducenta procesora ESP32, �rmy Espressif [3].
W porównaniu do pierwowzoru wprowa-
dzono kilka zmian: zrezygnowano z funkcji
rozpoznawania twarzy, dodano możliwość
zdalnej aktualizacji nowych wersji opro-
gramowania drogą radiową (OTA), wprowa-
dzono możliwość przywracania ustawień
kamery, uporządkowano i uproszczono wy-
glądwyświetlanychwprzeglądarce stron ge-
nerowanych przez moduł ESP32-CAM. No
i oczywiście dodano możliwość sterowania
serwami użytymi do poruszania ramieniem.
Można wybierać pomiędzy maksymalnie

uproszczonym widokiem strony sterującej
(rysunek 5), rozwinięciem z dostępem za-
równo do suwaków, jak i przyciskówprecyzyj-
nego ustawiania położenia ramienia z kamerą
(rysunek 6) albo uzyskać dostęp do wielu na-
stawkamery (rysunek 7). Przełączanie pomię-
dzy różnymi widokami strony z elementami
sterującymi uzyskuje się po naciśnięciu ele-
mentu oznaczonego jako Menu.
KlawiszGet Still powoduje kolejnewyświet-

lanie kilku ostatnich stop klatek. Klawisz
Start/Stop Stream wznawia lub wstrzymuje
transmisję strumieniową. Natomiast naciś-
nięcie przycisku Full spowoduje rozwinięcie
ekranu z nastawami parametrów pracy ka-
mery. Na samym dole listy nastaw dodano
napis Servo będący linkiem do podstrony

To samo dotyczy złączy J3, J4 do podłącza-
nia kabli serwomechanizmów. Następnym
krokiem jest przykręcenie podstawy ramie-
nia do dużej płytki drukowanej. Posłużą
do tego śrubki dołączone do zestawu mon-
tażowego ramienia o długości 6 mm i śred-
nicy 2 mm.
Należy poprowadzić przewody łączące

styki gniazda J1 małej płytki ze stykami
gniazda J6 dużej płytki oraz styki gniazda
J2 ze stykami J5. Połączone powinny być
ze sobą styki gniazd o tych samych nume-
rach. Do połączeń należy użyć cienkich kabli,
które nie będą stawiać dużych oporóww cza-
sie ruchów ramienia. W modelu użyto frag-
mentów szarego wielożyłowego kabla taśmy
komputerowej. Każdy z odcinków powinien
mieć długość 15...20 cm. Należy usunąć kil-
kumilimetrowe końcówki izolacji na krań-
cach przewodów, a druty żyły zagiąć do tyłu.
Następnie zacisnąć żyłę razem z izolacjąw ot-
worachkostek gniazd śrubowych.Dzięki temu
zapewniony zostanie kontakt elektryczny,
a przewód nie będzie się urywał podczas
ruchu ramienia.
Przewody można pozostawić swobodnie

albo przed zamocowaniemw gniazdach du-
żej płytki zwinąć w pętle i unieruchomić
poprzeczką przykręconą dwoma wkrętami
(po obu stronach dużego otworu) dowiększej
płytki. W modelu do mocowania pętli prze-
wodów zastosowano niewykorzystaną belkę
orczyka, skróconą i z nawierconymi otworami
dla wkrętów mocujących.
Na koniec w rogach większej płytki

można przylepić gumowe nóżki, które za-
pewnią lepszą stabilność całej konstrukcji.

Rysunek 7. Ustawianie parametrów kamery

PROJEKTY

Rysunek 5. Uproszczony wygląd pulpitu  
sterującego

Rysunek 6. Pulpit z elementami sterującymi 
ruchem ramienia
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Gdy zgłosi się strona Elegant OTA, należy
wybrać opcję Firmware i wskazać lokalizację
wygenerowanego podczas kompilacji pliku bi-
narnego (jeżeli korzystamy ze szkicuArduino
o nazwie esp32-cam-pan-tilt.ino, plik będzie
się nazywał esp32-cam-pan-tilt.ino.esp32.
bin). Gdy wyświetli się informacja o sukce-
sie zdalnego zapisu, należy nacisnąć przy-
cisk Back i w pasku przeglądarki wpisać IP
modułu bez numeru portu.

Bilans prądów
Moduł wraz z ramieniem zależnie od trybu
pracy mogą pobierać różny, czasem zna-
cząco wyższy prąd. Poniżej znajdują się war-
tości pomiarów dla różnych sytuacji przy
zasilaniu napięciem 5 V:
• serwa w trybie oczekiwania: 6 mA,
• 1 serwo stabilne 2 pracuje: 12 mA,
• moduł transmituje strumień obrazów:
ok. 180 mA,

• wstrzymana transmisja obrazu: 170mA,
• transmisja obrazu, lampa LED włą-
czona na max.: 330 mA.

Z pomiarów wynika, że zewnętrzny zasi-
lacz powinien dostarczać stabilnego napięcia
zasilania +5 V przy wydajności co naj-
mniej 500 mA.

Ryszard Szymaniak
biuro@ars.info.pl

[1] https://bit.ly/3HIN7oC
[2] https://bit.ly/3yclMrv
[3] https://bit.ly/3xR4Bux
[4] https://bit.ly/3xNOFZR
[5] https://bit.ly/3ybyy9M

pracy punktu dostępowego i utworzywłasną
sieć o nazwie i haśle z pierwszego miejsca
listy. Żeby tak się stało, należy odkomento-
wać pozycję
#dene WIFI_AP_ENABLE
Możesz także zmienić domyślny adres IP

punktu dostępowego, edytując pozycję
#dene AP_ADDRESS 192,168,4,1 (zwróć
uwagę, że kolejne pozycje adresu IP w tej
de�nicji są oddzielone znakiem przecinka).
Używając modułu AI-THINKER, pamię-

taj, aby linia
#dene CAMERA_MODEL_AI_THINKER po-
została odkomentowana.

Prawdopodobnie przedkompilacją będziesz
musiał w zwykły dla Arduino sposób doin-
stalować niektóre z wymienionych poniżej
bibliotek:
AsyncTCP
ESPAsyncWebServer
AsyncElegantOTA
uTimerLib
W przypadku gdy moduł ESP32-CAM za-

logował się do sieci, o jego numer IP w jej
zasięgu należy odpytywać router zarządza-
jący siecią. Po pierwszym zaprogramowaniu
modułu kolejne aktualizacje oprogramowa-
nia można już przeprowadzać zdalnie, drogą
radiową korzystając z trybu OTA. Najpierw
należy odpowiednio skompilować źródła
oprogramowania, korzystając z opcji Sketch→
Export compilet binary. Po zakończeniu kom-
pilacji w pasku przeglądarki wpisujemy adres
IP modułu uzupełniony o numer portu 83
i rozkaz update np. tak:
http://192.168.0.129:83/update

• CPU Frequency: 240 MHz
• Flash Mode: QIO
• Flash Size: 4 MB
• Partition Scheme: Minimal SPIFFS
(1.9 MB APP with OTA/190 KB SPIFFS)

• PSRAM: Enabled
Wybierz w ustawieniach port USB, do któ-

rego podłączony jest interfejs USB-Rx/Tx
za pomocą którego zaprogramujesz moduł
ESP32-CAM. Pamiętaj, żeby podłączyć:
• wyjście interfejsu Tx z UOR (GPIO3)
modułu,

• wejście interfejsu Rx z UOT (GPIO1)
modułu,

• zewrzyj wyprowadzenie GPIO0modułu
z GND,

• doprowadź do wejścia 5 V napięcie zasi-
lania +5 V o wydajności prądowej zasi-
lacza co najmniej 500 mA.

Pamiętaj, żebywyprowadzeniaTx i Rx inter-
fejsu pracowały z sygnałami omaksymalnych
poziomach 3,3 V. To ważne gdyż praca zwyż-
szymi poziomami może uszkodzić moduł.
Zanim przejdziesz do kompilacji, edytuj

plik mycon�g.h lub utwórz nowy o takiej
nazwie, korzystając z szablonu mycon�g.
sample.h. Jest to plik z prede�niowanymi
ustawieniami użytkownika. Uzupełnij struk-
turę struct station stationList[],
wpisując nazwę sieci (ssid) i hasło dostępu
(password). Można podać 2 pary parame-
trów dostępu do jednej sieci lub więcej.
Powłączeniu zasilaniamoduł zacznie szu-

kać sieci o nazwie z pozycji 2 lub kolejnych.
Jeżeli żadnej nie znajdzie i nie będzie sięmógł
zalogować, automatycznie przejdzie w tryb

Kamera z ruchomym ramieniem
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